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Excel 2002 

Excel 2002 is a spreadsheet used to calculate, organize, and analyze data.  In 
this handout you will find directions on how to perform some of the basic 

functions such as how to work with functions and formulas, 
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Excel 2002 

• Pull-Down Menu Bar - This bar contains commands and other options to 
help manipulate information in the worksheets.  

 
• Standard Tool Bar - This bar has a series of icons that help activate 

certain Excel Commands with the simple click of a mouse.  
 

• Sizing Buttons - These buttons are used to manipulate the size of the 
spreadsheet window. 

  
• Name Box - This box displays the active cell.  
• Formula Bar - This bar displays the data in the active cell.  

 
• Task Pane - You can use the task bar to carry out certain tasks one 

example is creating a new document.    
 

• Worksheet Tabs - These are new ledger sheets.  You can rename these 
sheets up to 31 characters.  

Renaming Sheet Tabs  
1. Right-Click on the tab 
2. Select rename and the old name becomes highlighted 
3. Type in a new name for the sheet 

 
• Status Bar – This bar displays the current settings and commands in 

Excel. Also, when two or more cells are selected, and one or more 
contains a value, the status bar displays a total for the selected cells.  
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Sheet Tabs  
 
You can now color code the sheet tabs.   

1. Right Click on the tab you would like to color.  
2. Select Tab Color from the list.  
3. Pick a color and click OK.  
 

Hide and Unhide sheet tabs  
1. Select the sheet tab 
2. Click on the Format pull-down menu and select Sheet.  

 
 
 
 
 
 
 
 
 
 
 
 
Find and Replace 

Select this option to 
change the 
spreadsheet 
background.   

Select this option 
to hide the 
spreadsheet  

 
You can now find and replace across an entire worksheet.  

1. Click Edit – Replace  
2. Click Options.  Under options you can format the replaced text as well as 

have Excel search within the Sheet.   
 
 
 
 
 
 
 
 
 
 

Select this 
option to 
search within 
the sheet.   
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Excel 2002 

Entering Information in a cell 
 
As you begin to type you will notice that your information will appear in the 
formula bar as well as in the cell itself.   Once you are done typing your 
information in a cell, you have to remember to ENTER that information.  If you do 
not enter your information in that particular cell then Excel will not let you 
continue to the next step.   
 
Ways to enter information in a cell 

• Clicking in another cell with the mouse 
• Hitting the enter key 
• Hitting the tab key 
• Hitting the arrow keys 
• Clicking on the green check mark on the formula bar.  

 
Moving within the Spreadsheet  
 
The mouse is easy to point, click, and drag but it’s sometimes difficult to control.  
Therefore there are several keystrokes that can be made to accomplish the same 
tasks.  

• The arrow keys allow you to move one cell in the direction of that arrow.  
• Ctrl Key + arrow keys will take you to the four corners of the worksheet  
• Ctrl + Home will take you to cell A1. 
• Page Up and Page Down will take you one sheet to the left or right. 
• End key + the right arrow key will take you to the highest column while 

Ctrl + End goes to the high cell.  
• Tab moves one to the right and Shift + Tab moves one to the left. 
• Ctrl + N will open up a new workbook  
• Ctrl + Page Down takes you to the next sheet in a workbook while  

Ctrl + Page Up takes you to the previous sheet.  
• Ctrl + Spacebar will highlight an entire column containing the selected 

cells.  
 
 
 
 
 
 
 
 

 
 
 

 
 

 5



Excel 2002 

Aligning Text in a cell 
 
Once the information in a cell has been entered Excel will look at that particular 
cell as a label cell; any character that Excel cannot interpret as a number, date, 
time, or formula or a value cell.  Text can be aligned in Label Cells in seven 
horizontal ways:  

• General - Left- justifies text and right-justifies numbers 
• Left - Left-justifies all entries (numbers, dates, and times) 
• Right - Right –justifies all entries 
• Center- Centers all entries 
• Fill - Repeats the entry to the desired cell  
• Justify – justifies wrapped text  
• Center Across Selection – Centers the text over selected columns.  

 
For additional alignment options follow the directions below: 

• Select the Format pull-down menu and then select cells  
• Select the Alignment tab  

  
Text Alignment 
 
Under text alignment you want to use the horizontal and vertical option to align 
the value or label in the cell.     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select an angle to 
situate your label 
or value cell by 
choosing one of 
the options below. 
   
 

1. Click on the red 
diamond and click 
and drag it up or 
down to your desired 
angle.   
 

Or  
2. Click on the 
arrows next to the 
word degrees.  
Or 
3. Click in the text 
box and type in the 
angle.  

Text 
Control  

Under the vertical pull- 
down menu you have 
the option to align the 
cell to the left, right, 
bottom and justify.  

Under the horizontal 
pull-down menu you 
have the option to 
center, right justify, 
left justify and fill. 
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Excel 2002 

Numbers (or values) are the raw materials, which the Excel worksheet 
processes. There are several formats for numerical display and they can be 
changed for a particular cell, a group of cells, and for an entire worksheet.  If you 
type the equal symbol, which tells Excel that the cell is a value cell, prior to typing 
a digit, plus or minus then the cell is labeled a value cell.  A number may have at 
most one decimal point and must not contain any commas or spaces.  
Calculations can only be performed on values.  *Remember to create a value 
cell you must always precede the data with an equal symbol.  
 

Formulas  
Formulas give you the ability to link other cells together to create powerful 
models that respond to changes you make in this parameter or that. A formula is 
a mathematical arrangement of one or more values, cell references, functions, 
and operators that produce numeric value.  The operators for formulas include:  
 

+ Addition 
- Subtraction 
* Multiplication 
/ Division 
^ Exponentiation

Functions  
A function is an abbreviation of a formula.  It provides a quick way to calculate 
the value of a cell that would often require a long expression.  Each function 
begins with an equal sign followed by the name of the function.  After the function 
name enter, inside parentheses, the set, range, or variables as well as any other 
sub formulas, each separated by commas.   
 
Ex: =Sum (A1:A5)   
The above function sums the values between A1 and A5.  
 
In Excel 2002 the Paste Function wizard and the Sum sign have been combined 
into one icon.   
 
If you really wanted the paste function you could 
always add that icon to your toolbar.   

1. Select View -Toolbars- Customize  
2. Select the Commands tab 
3. Under Categories select Insert  
4. Under Commands select the FX button and 

drag it to the toolbar 
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Comments  
 
You can add a comment to cells to document work, explain calculations and 
send reminders.  Follow the steps below to add a comment in the cell.   
 

1. Select the cell where the comment is to be placed.  
2. Click on the insert pull-down menu and select comment or you can right-

click inside that cell and select insert comment.  
3. Once you select insert comment a comment box will appear.   

 
 

x

 
 
 
 
 
 
 
 
 
 
 

4. Click inside the box to begin typing.  
5. Once you are finished typing select another cell on the sp

• You can hide and show a comment box.  To select eit
click in the cell with the comment box and select Show
Hide Comment.  

 
 
Viewing a comment- If you 
have the Hide Comment option 
turned on, to view the comment 
you will have to place your 
mouse over the cell and the 
comment will pop up. 
 
Editing a comment- To edit a 
comment right-click in the cell 
where the comment is located 
and select Edit Comment from 
the list.    

Show comm
available b
comment o
turned on. 

 
 
 
 
Note: One comment per cell.  
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Move and Copy  
 
Move and copy are two powerful features available with a spreadsheet package.  
It gives the user the opportunity to copy or move contents of a cell to another cell 
without having to retype the information.  The information can contain text as well 
as a formula or function.  One of the most outstanding things about this is the 
ability to copy a formula or function and the flexibility in Excel as it easily changes 
the cell labels.  
 
Before you move or copy in Excel you will need to remember the following 
information: 
 

• Source cell range:  This is the range or cell(s) that contain the 
information to copied or moved.  

• Destination cell range: This is the range of cell(s) that the information is 
to be copied or moved to.  

 
Copying Text  
 

1. Select the cell(s) that you want 
to move.  

Place your mouse 
over the box in the 
lower right hand 
corner of the last 
selected cell. 

2. Place your mouse over the 
bottom right corner of the cell.    

3. Hold down the left mouse 
button and click and drag until 
you come to your destination.   

 
 
Moving Text  
 

1. Right-click on the cell(s) you want to move.  
2. Select cut  
3. Click on the cell you want to move the information to and select paste.  

 
 
 
* Don’t forget your copy and paste commands in the Edit pull-down menu.  
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Changing column and row widths 
 
Place your mouse pointer between the Column or Row header; you will then get 
a cross.  Now take that cross and click and drag with your mouse to the left or 
right.  Another way to change the row and column widths is to double click on the 
line in between the headers.   
 

R
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w  
 
H
e
a
d
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r 

Column Header 

Line in 
between 
headers.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Changing two or more consecutive rows or columns using the mouse 
 
To change two or more consecutive rows or columns highlight all the rows or 
columns you want to change.  Then place your mouse between any of the rows 
or columns you have highlighted, you will see a cross.  Now, move the cursor in 
the direction you want to move the columns or rows.  
 
Symbol What it Means Solution 
#Value This error appears when the wrong 

type of argument or operand is used, 
or if the Formula Autocorrect feature 
cannot correct the formula 

Make sure the formula or function is 
correct for the required operand or 
argument, and that the cells that are 
referenced by the formula contain 
valid values.   

##### The numeric value entered into a cell 
is too wide and too long to display 
within the cell.  

Follow the directions in this handout 
for changing the width of a column.   

 
 
 

 10



Excel 2002 

Hide  
 
Columns  
 

1. Right Click on the column that you want to hide  
2. Select hide  

OR  
1. Go to the following menus Format - Column – Hide  

 
Rows  
 

1. Right Click on the row that you want to hide  
2. Select hide 

OR 
1. Go to the following menus Format – Row – Hide  

 
 
Unhide 
 
Follow the above directions except click unhide.  
 

 
You can also manipulate the sheet under Format.  In the Sheet option 
you will be able to hide the sheet, change the background, change the 
tab color, and rename the sheet.    
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Excel 2002 

 
In the Page setup box you will be able to manipulate things such as page 
orientation, header/footer, and margins.  
 
The Page Setup command is under File – Page Setup  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Tab Feature 

Page Tab Orientation setup, scaling, and paper 
size  

Margin Tab  Set page margins  
Header/Footer Set the header and footer for the 

spreadsheet 
Sheet Set the print area, select what you want 

to be shown on your page.  
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Saving a Workbook  
 

1. Click File 
 
Save  Saves the current file.   
Save As Option to change the location and file 

name.  
Save as HTML Saves the spreadsheet in HTML format 
Save Workspace  Saves display information so that you 

can later resume work with the same 
window sizes, print areas, screen 
magnification, and display settings.  
You can also save multiply worksheets 
under one name.  

 
Printing a file  
 

1. Click on File – Print  
2. Print box appears.  In this box change the printing options to your 

specifications.   
3. Click OK 

 
  

Select the 
printer you 
will be 
printing to. 

 

 

Select the 
pages to 
print.  
Select whether to print
the sheet or the entire 
workbook.  
13
Select how 
many copies 
to print
Click here to 
preview the 
spreadsheet. 


